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To install PC-Axis

PC-Axis can be downloaded from the Statistics Finland Website, follow the instructions on the website. Then follow
instructions in the installation program.

Some information on PC-Axis and its helpfunctions
There a few things good to know before you start using PC-Axis for the first time.
If you let the mouse stay over a toolkey in the toolbar a small yellow frame will tell the purpose of that very toolkey.

If you need more help, please use the toolkey that opens the help function. It is on the farest right
position in the toolbar. This key is the way to get help for menus, commands and how to work with
PC-Axis. Press the F1 keyboardkey to get context related help where ever you are in PC-Axis.
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A walk through of the toolbar

Open a database

Footnote

Select new values

Save

Print out

Undo

Copy

Pivot (clockwise)

Pivot (anti-clockwise)

Pivot any option

Sum

Percent

Per mille

Add

Subtract

Multiply

Divide

More information

Graphs

Maps

Search help
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Open a database in PC-Axis.

Picture 1.

When you are opening a table in PC-Axis, there are optional ways of doing it. If the program is running, you just press File �

Open Database or you can click on the button  and you will find the catalogue which contains the current database or
table. On this picture you can see the PC-Axis files all having the extension PX.
Picture 2

To be able to use the Classification function (see below) you must set the right catalogue for the classifications belonging to
the current database. It can be changed using the button Change Classification.. on Picture 2.

When you are going to select a new table you either can click on it, or mark it using the mouse and then press the ENTER
key.

Let us say that you are interested in Population statistics � press the subject �Population�, select the subcatalogue
�Population statistics� and then select the table named Mean population by region, age, period and sex. See Picture 3.
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Make a table in PC-Axis
Now it is time to select values for the variables � decide what the table shall contain.

Picture 3

Select values to the table
If you desire all values in a variable you can click on the namebar for the very variable selection box. As in sample on
Picture 3, where all, two, values will be selectged by clicking on the word sex.
If you only want some of the values, just press the CTRL-button at the same time as you click the left mousebutton on the
desired values. Then only those selected will be put into the table.

How to select all
If you wish to get all the variables and all their variable values, just click on the button All.

About classification of values
All variables can be grouped into a classification if desired. It shall be done before you select all variables with the �All�
button. See Pictureers 4 and 5.

You can use the classifications if you have a table which is more detailed than you want it to be. For example one-year
classes or municipalities. You can create your own age classifications or make your own areas based on the municipalities.

If you want to classify on variable age � in the selected table it is in one year classes, and you would prefer it to be five year
classes.
On the picture where you select the variables there is a button named Aggregate. Press it and it looks like Picture 4. You will
find what is avialable for classification for this very table, in this case the variables age and region. We select age.

Click here to select
all values

Selected values:
CTRL+mause
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Picture 4

Press OK. In next window you will find a list showing the different classifications available.

Picture 5

Select the 5-yearclasses and press on the OK button.
Then you will come back to Picture 3, but the list of ages has been changed to 5-yearclasses:
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Picture 6 a

When all selections are finnished, click OK and the table appears on the screen.

If there are very long texts on the variable values there is an option in PC-Axis to get an alternative menu. Just press the
button 'Long texts'.

Figure 6 b. If you tick the option �Use this layout as default�, the only way to alter back to the original layout can be done in
the menu View, Advanced, the tag �Information� where you can tick the box �Show value selection in layout with small
listboxes�.

The table will appear similar in both cases.

Picture 7
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Now you can click on the tool key with the icon of a star which gives the footnote information for this very table. In this case
latest up date, source, contact persons etc.

If there are additional information available the icon showing a little book in the toolbar will be activated. Press it and the
book will lead you to additional documents concerning this very material. It will be opened according what type of textfile it is
written.

To save a table
When you are satisfied with the layout of the table you can save it on your hard disc or a server. Use the pulldown menu
�File, Save as.. "
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Picture 8
Then a windows turns up where you can enter where to save the file and name the file.

Picture 9

If you would like to save the table in another file format you just select the tag �Convert� as in Picture 10.

Name

Location
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Picture 10

In the listbox File Format you can save the table in any of the optional file formats.

To edit a table in PC-Axis
If you are not satisfied with the layout of the table there are some different things to be done to change it.

The Pivot function can be used to let the variables change places in the table. Stub and heading can be switched according
to your own needs. Press this button , which give you total freedom to move around with the variables. You are using a
drag and drop technique as showed on Picture 11:

Picture 11
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When you are satisfied just press OK and the new table turns up. This can be repeated so you will realy be satisfied with
your table.

To do simple calculations using PC-Axis
There are some simple tasks able to carry out with the PC-Axis calculation toolbox. Let us study some samples.
Click on the pull down menu Calculate as showed on Picture 12 and you will find the different options.

Picture 12

Let us try the percent calculation as is marked in the picture 12 above. Then the following window pops up:

Picture 13.
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If we wish to calculate the ratio female and male compared to the total we select the total for the variable sex as the base for
the operation. Then you will be prompted a name of the new established value.

Picture 14

PC-Axis will automatically suggest the name �Per cent�, you can change it if you wish and then click OK.

Now all the figures will turn up on the screen. If you did not wish to have the initial values left in the table there is a possibility
on the base selection window to tick according to your wishes. See picture 15.

Picture 15

Change texts in the table
It is also possible to change the texts in the column headings and the stub. Use Edit Change texts...  Here you mark the
variables you want to modify, the variable name and also variable values are possible to change.
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Updating tables
If you have a table that contains the population in sixteen municipalities, distributed on age, sex and time (1995-2000), and
the figures for 2001 has become published it is possible to update with the new figures instead of download the whole table
again from Sweden�s statistical databases on Internet.
You just link a table to another table (adding new values).
It is also possible to overlay a table with another table (adding a new variable), for example if imigration and emigration are
retrieved from two separate tables they can be put together in a very large table using this function.

Please notice when using these two functions the tables have to be very similar. So if something is changed in one of the
tables the other has to be changed in exactly the same manner to fit in together.

Picture 16
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To use these functions, click Edit and then Link with table../Overlay with table. See Picture 16.

You will then be prompted what catalogue to pick up the second table from. Be aware that you are only offered the tables
that are possible to put together. Select the table you want to have and click OK. Then your table on the screen have got
new values or variable.

If you are using Link with table it is a matter of adding a new time period.

When using Overlay with table it is because you have to similar tables possible to put together.

To make graphs in PC-Axis
When you have a table in PC-Axis it is possible to make a graph out from it. It is possible to make different types of graphs,
like charts, line diagram and population pyramids. There is also possible to make thematic maps that will be showed later
on.
If you want to make a graph, please click on this icon:   and the picture below will turn up where you can select from
different types of graphs.

Picture 17

If you press the button �Adjust..� you will get some options to change in the graph.
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Picture 18

To coopy a graph
You can use the option copy in the graph window and insert the graph into another Windows program like MS-Word and

MS-Excel. Just click on this button .
When arriving to the other program where the graph is supposed to be inserted use the �paste special� option using �bitmap�
format. If not using this, a table will apear instead of the graph in the windows program.

Notice
Notice that some of the graph options need a certain structure of the table. For example a population pyramid desires that
the age variable is in the stub alone and the sex variable is as column heads. If you are violating these rules PC-Axis will tell
you what is wrong for a certain type of graph.

When you have moved a diagram to Excel you must notice that it is just a picture which is not possible to adjust in Excel.
If you on the other hand transfer a table it is of course possible to continue to work on this table in Excel.

PX-Map � presents the statistics as a thematic map
Using the PX-Map makes it possible to transfer your table information into a thematic map. If you are using the CD-ROM
Statistics Across the Borders and want a regional distributed table to be a map, just click the globe icon in the toolbar - .
All tables can not be presented as maps. If it is not possible the icon is non collored.

This is how a thematic map in PX-Map looks like:
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If you retrieve a table from the Sweden�s Statistical databases there is not yet made any link to Maps.

To make a Map link
If you insists to make a map from a table retreived from Sweden�s Statisitcal Database on the Internet, download the table in
PC-Axis file format to your computer and save it. Then you open the file in a text editor like MS-Word. Search for a section
looking like this:

TITLE="Mean population by region, age, period and sex.";
CONTENTS="Mean population";
UNITS="number";
STUB="region","age";
HEADING="period","sex";
MAP("region")="Sweden_municipality";

Insert the line:

MAP("region")="Sweden_municipality";

You have to insert this line after STUB and HEADING which is in the beginning of the file.
When you save the file again (be aware of that MS-Word tries to change the extension of the file when saving in another file
format than doc. Save in txt format and change the extension to PX) it is possible to find the file from PC-Axis and make a
map in PX-Map. A more detailed description of PX-Map is in a separate Users Manual available on the CD-ROM Statisitcs
Across borders.

About advanced functions in PC-Axis
The presentation of figures in the table cells can optionally hold thousand delimiters. Use the menu View, Advanced
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Picture 19

Where you select the tag �Format for data cells�:

Figure 20.

Then mark the type of thousand delimiter you want to use in the tables. The selected option will work from the next table
opened in PC-Axis.

PC-Axis optionally can be linked to another software. Then it is possible to launge the other program from PC-Axis moving
the present table into that very program. To make such a link use the menu View, Advanced. The installation program will
automatically establish such a link to MS-Excel if it is available on the computer.
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In the new window select a folder named More Features and then click on Additions. Now use the folder Other programs

andthe button . And you will find this window:

Picture 21

the installation program links Excel automatically, and in the dialog box there are options to create links to three other
programs. To create such a link PC-Axis needs the following informations:

− The name of the program is entered in the Menu text field. If a & sign is entered before a letter in the name this gives
a key shortcut for that letter. The program name will appear as a line in the File menu in PC-Axis.

− The file type for the program is entered in the field File type.
− In the field Program the path and the name of the exe-file has to be entered using Browse support. If you can not find

the program search for it using the File explorer search function.

When you getting back to PC-Axis you will find a line added in the File menu named 'your program'.
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Picture 22

When you click on the Excel line PC-Axis automatically will pass the table on into Excel. In Excel the table will be put in a
new sheet and footnotes will appear below the table in Excel.

Table size
Another thing to be happy about concerning PC-Axis is the capacity to handle tables consisting of millions of table cells.
One more thing that make you glad is that you do not have to watch all these table cells on the screen. The more table cells
you show on the screen the longer it will take to make operations on the table. Furthermore it uses more RAM. So it is
possible to reduce the number of table lines to be exposed on the screen.
Click on View, Advanced and select a tag called Table Presentation.
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Picture 23

Here you can set the number of lines you as a maximum want the table to use on the screen. Remember that even if you
cannot see the table on the screen you can work with the whole table. Everything you do will effect the whole table.

It is easy to change the table layout. If you do not want to have line numbers, gridframes just enter the View menu omit or
insert the different properties.

Picture 24

Within the program it is possible to copy, move or delete tables and subject matter areas. When you are doing it in PC-Axis
you are sure that all references are deleted at the same time.

Click on File,  Maintenance...
Copy, move or delete a table within a subject matter area. Select Copy/Move or Delete in the dialog box Maintenance.
Select a subject area as �Population� and delete, copy or move the tables.

Classifications�
Former mentioned classification will be elaborated and explained and you will see how useful the classifications can be.

The principle is that from a value set define a classification register that contains the desired summings. The classification
register then can be used on all files where the very variable classified is used. One usefull area  is on the variable age
where several different classifications can be established. Another is on region where municipalities can be put together in
larger areas forming special divisions of the country.

It is not a must to make classification registers, it is possible use the sum function in PC-Axis. The advantage is the
possibility to reuse the classifications. It is obviously possible to make your own classification if the ones delivered from the
statistical office on CD-ROM or on Internet is not exactly the one you want to use.

To make a classification list takes some time, but you gain from it every time you use it in the future.

To change the table layout
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To create a classification based on an existing value set.
Open File, Classification...

Picture 25

Select among the valuesets available in the listbox. For example ALDER1, or use Browse if you want to change to another
classification catalogue. (If the value set is on a read only medium, as a CD-ROM, you have to copy it into your hard disc or
a server and change property to not read only status.)

Picture 26
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Press Continue..

Picture 27

To avoid manual data entry you can use the option Read from file... and you will find a window with allready existing value
sets.

Picture 28
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Now the page will be filled with values from the selected value set (text and codes) for example ALDER1, the name of the
domain and the type of value set (V=Value set of normal structure, H= Hierarcical value set, N=sub areas). Press on the

button named Aggregations. 
Picture 29

1. In the upper field the name of the aggregation list is entered, for example 10-yearclasses. This name will be used in the
table heading when this aggregation list is used.
2. In the next field every single group is named (Code and text), for example 0-9 in both fields in this case. Before every
new group you press the button Add.
 3. In the bottom field you select the values that shall be included into the group for example 0, 1, 2, 3, 4, 5, 6, 7, 8, 9. They
will be found in the right hand side list and then transfered to the left using the arrow key on the screen.

If it is not ticked on �Allow values in a group to overlap� the values will dissapear from the right hand box when clicked to the
left. This is the most common way of using classification.

If you make groupes that contains for example 0-4 years and also one 0-9 years it is necessary to tick the �Allow values in a
group to overlap� button. This because 0-4 is a subset of 0-9.

Use the Show button to check the result.
Then save.

To create a classifictaion based on a new value set.
To be able to create aggregations based on values not available in a classification register, you first have to import that
values. The value set is a file containing codes and texts for the values to be aggregated from. For example �0� with the
corresponding text �0 year�. The code �1� with the corresponding text �1 year� and so on. Value sets can be read into PC-
Axis from a commaseparated file which could look like this:
0,0 year
1,1 year
2,2 year

1

2

3
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It is also possible to import an existing value set (a file with the extension VS) to optionally correct it. At most cases it is a
PC-Axis file one want to make aggregations for and then the PC-Axis file can be used as input to get the value set.
To be able to use the aggregations one shall secure the consistency between the PC-Axis files and the aggregations lists.

Domain is a keyword that can occur for any variable. It refers to a class of values. A list with all names of existing domains
can be seen from the Classification program if the right current database is linked. The name can also be found with the
Domain keyword in the PX-file. This name is to be used when establishing a new value set.

When using the aggregation lists you shall secure the right classification catalogue is linked to PC-Axis.

What is wrong?
If you after having created a classification register do not access to it when opening a table the reasons can be the following:

•  The Current Classification catalogue does not contain the created classification register. Shift classification
catalogue. Do it at the same places as where you shift database. It is also possible to set a default catalogue in
�View, Advanced..�. Select �Classification Directory� and set the desired catalogue.

•  DOMAIN is not corresponding between the PX-file and the value set. Open the PX-file in text editor ( or in PX-Edit )
and check if the name corresponds to the value set.

Picture30

Saved Queries in PC-Axis Main Module
PC-Axis 2004 introduces the possibility to record a sequence of work and run as a batch. You can
record calculations, pivot and convert. It is also possible to decide how the time variable is to be
treated: Select for instance to always use the last time period(s), or to start with the same time period
but add new time periods as they are available.
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To use this option you start by selecting recording under the file menu

You will be prompted for a file name for the bat file that will be created for your selections.
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Next you select the PX file under 'Open database' and the variables and values you want to have

The table will be shown as usual
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Continue chosing whatever editing and calculations you wish to do, for instance pivot

You can also select 'Save as'
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When you are ready stop the recording

You will see all the steps you have selected since you started recording. Select the first line and make
the necessary changes of the file names. By default you have got a saved query containing 'tmp' and
you need to find a more suitable name. If you have steps that depend on a new file in the previous step
the input file name will automatically be updated when you give a new name for the output file. When
you have made the changes press the Update button. 
For steps that involve selection from a PX file you can pres the button Time Options and decide how
time periods are to be treated each time the query is run (only possible when the px file contains the
keyword Timeval)
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Repeat the selection and update for each line in the list. When you have done so the button Save will be
available.

You get a confirmation what has been created and you can run the job as often an you need by selecting
run in PC-Axis or by double clicking on the bat file in Windows Explorer.

_____________________________________________________________________________________________


